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The Basics
[bookmark: _Toc287434670]Moving to the Ribbon Bar:
Alt-key moves the focus to the Ribbon Bar. A single letter is associated with each Ribbon Tab.
[image: Ribbon Bar]
[bookmark: _Toc287434671]Available Ribbons:
F – File Menu (Office Button in Word 2007)
H – Home 
N – Insert 
P – Page Layout
S – References
M – Mailings
R – Review
W – View
L – Developer
X – Add-Ins
Y – Custom Ribbons Added by User or Independent Programs
Shift-Tab – Quick Access Toolbar
Note: Other Ribbons appear when working with special objects. The Picture Tools Format Ribbon appears only when a picture is selected; the Table Tools Design and Table Tools Layout Ribbons appear only when inside a table.

Note: All shortcuts require holding down the modifier key and tapping the next key. In this document, the modifier key is underlined. You can create a New Document by using the shortcut: Ctrl-p. That is you hold down the Ctrl-key and tap the n-key. The other way to create a new document is by going through the File Menu (Office Button): press and releasing the Alt-key, press and release the f-key to open the File Menu, and then tap the n-key to activate the New Document dialogue box. Press the Enter key 3 times to create a New Blank Document. 

[bookmark: _Toc287434672]Navigating the Ribbon Bar:
There are two ways to navigate the Ribbon Bar in Office 2010. The best way is with the letter commands built into each Ribbon Tab. The Alt-key moves the focus to the Ribbon Bar and displays the letters available to the user. At this point it is limited to the single letter needed to activate each Ribbon Tab (h-Home, n-Insert, p-Page Layout, etc.), the File Menu (Office Button in Word 2007) and the numbers for the Quick Access Tool Bar (1-save, 2-undo, etc.).  Once you activate a Ribbon with one of these keystrokes a whole new list of shortcuts becomes available. Alt-h activates the Home Ribbon. There are now over 40 additional single and double letter key commands available to the user (FF-Font Face; FS-Font Size; U-key start a bulleted list, etc.). The key commands for each Ribbon are listed in later sections in this book.  If you moved to the Home Ribbon with an arrow key however, the letter key commands become disabled. The only way to move to each individual tool within the Home Ribbon after using the arrow key is with the Tab or Shift-Tab keys.  
If you do not know the keyboard shortcut you will need to hunt for each tool with the arrow and Tab keys. Again, the Alt-key moves the focus to the Ribbon Bar, use the left or right arrow key to move to the Ribbon you want to explore. Next press the Tab-key to move through the available tools in that Ribbon or Shift-Tab to move through the tools in reverse order. Once you begin to move through any Ribbon with the Tab keys you can no longer use the letter-key shortcut command; they have become disabled. You can reactivate the letter shortcuts by escaping out of the Ribbon bar back to your document and moving back using only the letter keys available (Alt-key Ribbon Bar, h-Home Ribbon, fs-Font Size). 
[bookmark: _Toc287434673]Basic dos and don'ts for navigating the Ribbon Bar
1. Use shortcut commands whenever possible (Ctrl-p = Print, Ctrl-s = Save, Ctrl-e = Center text, etc.) See command summary at the end of the manual.
2. Alt-key activates the Ribbon Bar.
3. Escape key returns you to your document. You may have to press Escape several times depending on how far you have drilled down into the tools. 
4. Use letter commands to move to each Ribbon bar. (h – Home Ribbon, n – Insert Ribbon, etc)
5. Use the single or double letter commands, if you know them, inside each Ribbon. (fs – Font Size)
6. If you do not remember the key commands:
a. Use the right or left arrow keys to select the Ribbon
b. Use the Tab (shift-Tab) to move through tools within each Ribbon. 
7. If you want to work with more familiar group dialogue boxes, learn the commands to open them:  Ctrl-D is the shortcut to open the Font Group Dialogue box. (You can also move there through the Home Ribbon: Alt-key moves the focus to the Ribbon Bar, h-Home Ribbon, fn-opens the Font Dialogue box). 
8. If you find yourself repeating the same command, add that tool to the Quick Access Toolbar (See the section, the Office Button) 
The File Menu (Office Button in Word 2007) is laid out differently than the other Ribbons and will be discussed separately. It is activated with the Alt-key followed with the f-key (File Menu). (See the next section, Office Button.)
[bookmark: _Toc287434674]Examples of Navigating the Ribbon Bar
Example 1: Inserting a Table using key commands
Press the Alt-key to move the focus to the Ribbon bar. Next press the n-key to open the Insert Ribbon. Notice that all the letter codes for the tools in the Insert Menu are displayed (V-Cover Page, NP-Blank Page, B-Page Break, etc). Press the T-key to open the "Insert a Table" dialogue box. Use the arrow keys to select the number of columns and rows you want followed by the Enter key. 
Example 2: Inserting a Table using Arrow and Tab-key 
Press the Alt-key to move the focus to the Ribbon bar. Press the right arrow to move to and display the Insert Ribbon. Notice there are no letter codes displayed for this ribbon once you use the arrow key. If you press the t-key to insert a table, there is a tone indicating that letter option is not available. Press the Tab-key until you hear "Table". Next press the Enter key and use your arrow keys to select the number of columns and rows you want followed by the Enter key. 
In both methods, a table was inserted into your document. It is important to understand that once you begin to navigate the Ribbon Bar using the arrow key or Tab-key you no longer have the option to use the letter shortcut commands. 
Once you select a ribbon (using a letter-key or Arrow), press the Tab-key to move from tool to tool within the ribbon. It is not recommended using the arrow keys to move around the tools in a ribbon. Since the tools are tiled, it is easy to miss a tool or to get caught inside an edit box. Again, use the tab key once inside a ribbon. You can also explore the ribbon in reverse order by using the Shift-Tab keys. Note that it is not a direct route, as it takes you through the Quick Access tools, the Office Button, Help and only then to the last tool on the active ribbon. Continue pressing the Shift-Tab key to move back though the ribbon tools. Again, once you begin using the Tab-key to navigate though a ribbon you cannot then use a letter shortcut command. 
Example: Press the Alt-key to move to the Ribbon Bar. Next press the H-key to activate the Home Ribbon and display all the letter shortcut keys. Press the Tab-key to move to the first tool (Paste). Notice all the letter shortcut keys disappear. You can still tab to each available tool in the Home Ribbon, but you cannot now press the U-key to start a bulleted list. Continue to press the Tab key until you hear "Bulleted List", press Enter to activate this tool and use your arrow keys to select the bullet style. Then press Enter again to start a bulleted list. 
[image: Ribbon Navigation.jpg]
[bookmark: _Toc287434675]File Menu – MS Word 2010
Below is the File Menu for MS Word 2010. It is significantly different than the Office Button (File Menu) for MS Word 2007. Each product will be treated separately. 
The Alt-key activates the Ribbon Bar and the F-key opens the File Menu.
[image: ] 


[bookmark: _Toc287434676]Available File Menu Choices:
Open the Office button (Alt-key, f), then use one of the following keys. 
Use the shortcut key combination, when available to bypass the Ribbon Bar. 
S – Save (Document) Ctrl-S
A – Save As (Document)
O – Open (Document) Ctrl-O 
C – Close (Document) Ctrl-F4 (Leave Word Open)
I – Info
R – Recent
N – New (Document) Ctrl-N
P – Print (Document) Ctrl-P
D – Save & Send
H – Help
T – Options
X – Exit Word Alt-F4
Note: For those of you who have tried to work in Word 2010 with a screen reader you quickly notice that key commands often do not work as you would expect. It is no more evident than here in the File Menu. For example, the Alt-key moves the focus to the Ribbon Bar, the F-key opens the File Menu and the R-key displays the most Recent files and folders accessed on this computer. This is the view in the graphic shown above. Notice there is a key command, the letter P, that will activate the most recent Places. After pressing the P-key, you would think the arrow or Tab key would allow you to move through the most recent places. Wrong! A down arrow will move you down the original File Menu options to the New (document). The focus did not follow your keyboard command. The focus remained on the original options in the File Menu. (If MS Word 2010 were human, one might suspect some psychological disorder.) The typical screen reader is silent after moving to the most recent places because the focus did not change. Sighted trainers will be more confused by this than the person using the screen reader. First of all, the blind student will not know of the existence of this letter command unless the sighted trainer asks her to navigate using it. It is important for both the trainer and the student to listen to their screen reader carefully. 
As we explore each of the “Available File Menu Choices”, I will make recommendations on the most efficient ways to navigate each choice. Students will explore and experiment with different navigation techniques and find one that works for them. They will remember some common shortcut commands and ignore others. Sometimes the student will use the shortcut and sometimes navigate through the Ribbon Bars. The goal is for the student to use MS Word 2010 as efficiently as possible. They should have access to as many features as possible and the ability to correctly apply them to their documents. 
 


[bookmark: _Toc287434677]File Menu – Save, Save As and Open Dialogue Box
[image: ]
The Save, Save As, and Open commands work in similar ways. The Alt-key activates the Ribbon Bar, the f-key opens the File menu and the s-key opens the Save as dialogue box; the o-key will open the Open (file) dialogue box.  It is important to note that once a document is saved, you will not see the Save as dialogue box again. When you save it again, Word automatically saves the document with the same name and in the same location and immediately returns you to your document. To save a document with a different name or in a different location after it has already been saved, you need to go to the Save as option (Alt, f, a). 
Basic navigation of the Save, Save as and Open dialogue box include the Tab-key to move through options in one direction and Shift-Tab to move through options in reverse order. 
When first opened, the dialogue box's focus is in the File name edit box. You can accept the default file name (not recommended) or simply type over the highlighted text. There is no need to first delete the text because it is already highlighted and highlighted text is replaced as soon as you begin to enter new text. 
· The first Tab stop is the "Save as type" (combo box). A combo box has a list of options that appear with a down arrow. You can also select items in a combo box by using the first letter of the file type (p = PDF, p = plain text). 

· The "Save Thumbnail" is a checkbox and can be checked or unchecked with the space bar.  

· The "Save" and "Cancel" tab stops are buttons and can be activated with the spacebar. 

· The Split Button at the top of the screen allows a student to select part of a folder "tree" to explore. Use the right arrow to move through branches and down arrow to explore individual locations on each "branch". 

· The list on the left side of the screen and the Documents Library in the center of the screen are lists and can be explored with the arrow keys or first letter navigation (r-key for removable disk, etc.).



[bookmark: _Toc287434678]File Menu – Save, Save As 
Alt-key, f, s opens the Save As dialogue box
[image: save save as.jpg]
The picture above is the default view of the Save As dialogue box. Some areas of the screen are not fully accessible and often times your screen reader simply does not give you enough information about your current location. So the first thing to do is make some changes to how the Save As dialogue box looks. 
1. [image: Layout.jpg]Move to the "Organize button" near the top, left area of the screen. Press the space bar to open it and use the down arrow to the Layout menu item.  Make sure to uncheck all options inside this menu item except the Navigation Pane. This will eliminate the Documents Library view in the Save As dialogue box. 
2. Next make sure the Documents folder is selected on the left edge of the screen (tree view). Right click (or press the application key – third key to the right of the space bar) to open an options list. Arrow down to "new" and create a new folder. Name it ",Document Folder List". Next make sure the folders are listed in alphabetical order. The comma at the beginning of the folder name insures it will appear first when the list is alphabetized. Now when you enter the Documents folder list area (items view) your screen reader will read this name first. 
3. From the Organize button, press the right arrow two times or until you hear "View" option. Press down arrow to open this option and choose "Details". This gives you a single list of folders and files in the items view area of the dialogue box.  
Save a Document
1. When you open the Save as dialogue box, (Alt, f, a) the focus begins in the File name edit box. Text is highlighted so you can simply type a name over the default file name and press Enter. The document is saved in the default location.
2. [image: Removable Disk k.jpg]Saving a file to a thumb drive (if you know its assigned drive letter). When a thumb drive is inserted in a USB slot, an Auto Play dialogue box appears. The top of the dialogue box displays the drive letter assigned to the thumb drive. (The JAWS command to read that information is Ins-B.) The next time you save a file to your thumb drive in MS Word, just type the drive letter (k), the colon key (:) , the backslash (\) and finally the file name (k:\junk2) . When you press Enter, the file is saved on your thumb drive.  
3.  The location where you save a file can be changed by Tabbing to the "Tree View" area of the Save As dialogue box. (Jaws command to announce your location is Ins-B) The Tree View is located 3 Shift-Tab stops from the File name edit field (If you eliminated the Library Document View - see above). The tree view area is a list and can be navigated with the arrow keys or by first letter navigation. If you want to save a document to your desktop, press the f-key until you hear your screen reader say "favorites". If it is closed, press the right arrow to expand the favorites view and down arrow (or d-key) to your desktop. Press Enter to select the desktop as your location. Now move back to your File name edit field (Alt-n), type a name for the file and press Enter to save the file to the desktop. 
Note: Expand a folder or location in the Tree View area with the right arrow; contract the folder or location with the left arrow. 

        

     

[bookmark: _Toc287434679]File Menu – Open
Alt-key, f, s opens the Save As dialogue box
[image: Open 2.jpg]

1. The Open dialogue box in MS Word 2010 opens with the focus in the file name edit box. Type in the first 3 or 4 letters of the document you want to open. As you type, a list of files matching your search is generated. Press the down arrow to explore this list of documents. It is important to understand that the Open dialogue box will only find files that begin with the letters you type. When you find your document, press Enter.
2. Open a file from your thumb drive, (If you know its assigned drive letter). In the File name edit box, type in the drive letter, followed by the colon (:), followed by the backslash (\), and then the Enter key. This refreshes the items in the list view. Press Shift-Tab twice then down arrow to select the folder or file. Press Enter to open a folder and display its contents. Again use your arrow keys to locate your file and press Enter to open it. Pressing backspace in this area will back you out of a subfolder.
3.  The location where you open a file can be changed by Tabbing to the "Tree View" area of the Open dialogue box. (Jaws command to announce your location is Ins-B) The Tree View is located 3 Shift-Tab stops from the File name edit field (If you eliminated the Library Document View - see above). The tree view area is a list and can be navigated with the arrow keys or by first letter navigation. If you want to open a document on your desktop, press the f-key until you hear your screen reader say "favorites". If it is closed, press the right arrow to expand the favorites view and down arrow (or d-key) to your desktop. Press Enter to select the desktop as your location. Now Shift-Tab back to your List view and down arrow to find the file you want to open and press Enter.
4. The easiest way to open a previously saved document however, may not be with the Open dialogue box, but through the Start Menu. In Windows 7, when you press the Window key, the Start Menu opens and the focus is in a search edit field at the bottom of the screen. Type in the first 3 or 4 letters of the document you want to open. A list is generated in the Start Menu showing programs, folders and files containing those 3 or 4 letters. You do not even have to remember the name of the file, as long as you remember some of the text found inside the document. I try to avoid the "see more results" link at the bottom of the screen. While a screen reader can navigate the next screen, I prefer to type a few more letters or use a different search string to narrow my results.  Press the down arrow to move through the list of files. When you find the file you want to open press the Enter key. Since the file type (doc or docx) is associated with MS Word, it will open the program and display the document on the screen. Some screen readers cannot read the major categories titles such as Programs or Files, [image: start button search field.jpg]so if you hear nothing from your screen reader, try pressing the "read current line command (Jaws is Ins-up arrow or Ins-8 on the numeric keypad).


[bookmark: _Toc287434680]File Menu – Info Menu
Alt-key, f, I, opens the Info Menu. 
[image: Info.jpg]
This menu is not commonly used and in some areas is completely inaccessible to a screen reader.   However, since there are those who may require some of the tools found in the Info menu, I have listed the letter shortcut commands. 
P – Protect Document
I – Check for Issues
R – Merge Versions
X – Return to Document (Escape)
QS – Properties
S – Size
QP – Show all properties


[bookmark: _Toc287434681]File Menu – Recent Menu
Alt-key, f, r, opens the Recent Menu
[image: Recent.jpg] 
The Recent menu is not very useful for a person using a screen reader. There is no first letter navigation and if you use the key command (P) to jump to Recent Places, it only activates the letter key commands that most screen readers cannot read. The only way to navigate the Recent Menu is with the Tab key to move to Recent Documents area and then Tab or down arrow through the lists. You can also use the Shift-Tab to navigate in reverse order. 
The only reason to use this menu is if you cannot find a file you worked on recently and cannot remember the file name or contents of the document. However, if you can remember something about the document, it is easier to find and open it by going through the Start Menu (Window key) and typing 3 or 4 letters in the search edit field (see chapter on Save, Save As and Open Dialogue Box).  


[bookmark: _Toc287434682]File Menu – New Menu
Alt-key, f, n, opens the New Menu
[image: New.jpg]
If all you want to do is create a new blank document the fastest way is with the shortcut command Ctrl-n. You can navigate the options and templates by pressing the Tab key and right arrow though the options. When you arrow though the last option the focus returns to the first "blank document." Press Tab three times to get to online "Office Templates." All the templates are laid out in a tiled format. You can use your up, down, left and right arrows to move though the choices. There is also limited first letter navigation. If you want to jump to Forms templates press the letter f. The focus moves to the first item beginning with f (Faxes). Now you will need to press the right arrow to move through any other templates beginning with f (Flyers, Forms). 
When you move to the end of a row with the arrow key, the next right arrow moves you to the beginning of the same row. Use the down arrow to go to the next row and continue your right arrow to review this row of templates. 
Create a new blank document – Ctrl-n
Alt, f, n, Enter, Enter, Enter
Alt, f, n, L, Enter
[bookmark: _Toc287434683]File Menu – Print Menu
Alt-key, f, p, opens the Print Menu
[image: Print.jpg]
The easiest way to print one document to your default printer is with the shortcut command Ctrl-p.
[bookmark: _Toc287434684]Available Print menu options
 P – Print
N – Number of Copies
I – Printer selection
R – Printer Properties
A – Print All Pages
S – Selected Pages (edit box)
D – Print One Sided
C – Collated
O – Portrait Orientation
L – Letter (8.5x11)
M – Normal Margins
H – 1 Page Per Sheet
G – Page Setup
You can move through the print options with the Tab key or Shift-Tab in reverse order. 
Print Current Document to Default Pinter – Ctrl- p, Enter.
Alt, F, P, P
Alt, F, P, Enter, Enter, Enter



[bookmark: _Toc287434685]File Menu – Save and Send
Alt-key, f, d, opens the Save and Send Menu
[image: save & send.jpg]
This is a moderately useful menu if you need to save a file in PDF format or send an email or Fax. 
[bookmark: _Toc287434686]Available Save and Send Menu Options
E – Send Using E-mail
K – Save to Web
S – Save to Share Point
B – Publish as Blog Post
C – Change File Type
P – Create PDF/XPS Document

Press the Tab, down arrow to move through the list above
Press Tab, Tab down arrow to send using e-mail (if your computer is set up to send e-mail)


[bookmark: _Toc287434687]File Menu – Help Menu
Alt-key, f, h, opens the Help Menu
[image: Help.jpg]
The Help Menu is located on the Internet and will require an Internet connection. 
[bookmark: _Toc287434688][image: Help 2.jpg]Available Help Menu Options
H – Microsoft Office Help
S – Getting Started
C – Contact Us
O – Options
U – Check for Updates

Opening Office Help creates a connection to the internet and provides an edit field to enter a search string. Type text into the edit field and press Enter. Results are displayed as links with a "heading" tag. That means you can jump to your search results by jumping from heading to heading if your screen reader is capable to doing so. (Jaws: press h to jump to next heading and Shift-h to backup to previous heading). You can also list your links (Jaws: Ins-F7) and use the down arrow to move from link to link. Press Enter to activate your link. You can navigate Office Help using the same key commands you would use in Internet explorer.      



[bookmark: _Toc287434689]
Office Button (File Menu) in Word 2007
Alt-Key followed by the F-key opens the Office Button (File Menu)
[image: Office Button.jpg]
Down arrow will go through the typical file menu options: New, Open, Save, etc. 
Right arrow will move to the Recent Documents list, followed by down arrow to move down the list of recent documents. 
[bookmark: _Toc287434690]Available Office Button Choices:
Open the Office button (Alt-key, f), then use one of the following keys. 
Use the shortcut key combination when available to bypass the Ribbon Bar. 
N – New (Document) Ctrl-N
O – Open (Document) Ctrl-O
S – Save (Document) Ctrl-S
A – Save As (Document)
F – Save a Copy Options
P – Print (Document) Ctrl-P
W – Preview and Print Options
R – Prepare (Document for distribution)
D – Send (Document)
U – Publish (Document)
C – Close (Document) Ctrl-F4
I – Word Options (Default Settings)
X – Exit Word Alt-F4
[bookmark: _Toc287434691]Word Options (Office Button)
Alt-Key followed by the F-key opens the Office Button (File Menu). The I-key opens the Word Options dialogue box. Use your down arrow to move down the list of major topics in the Word Options. Use the Tab key to move through the options inside each of these topics.  
 [image: Word Options.jpg]       [image: Word Options - Customize.jpg]
Popular – Basic changes to Word 2007: Color scheme, language, Live Preview
Display – What is visible on screen: Page display, Formatting marks and Printing Options
Proofing – Auto correct options
Save – File format (*.doc or *.docx), default save location
[image: Quick Access Tool Bar.jpg]Advanced – Editing, cut, copy, paste, display, print, save, and compatibility options 
Customize – Customize the Quick Access tool bar and keyboard shortcuts
Use this feature to add commonly used tools to the Quick Access Toolbar. If you need to change fonts or font sizes frequently, simply add these features to the Quick Access toolbar. You access the Toolbar by pressing the Alt-key followed by the number assigned to that tool.   
Add-Ins – View and manage Office Add-Ins
Trust Center – Adjust Trust Center settings
Resources – Information on MS Word including the Word 2007 version number and service pack updates


[bookmark: _Toc287434692]Home Ribbon
Alt-key followed by the H-key moves the focus to the Home Ribbon
[image: Home Ribbon.jpg]
Each option in a ribbon can be selected with a single or 2-letter short cut. 
Tab key will move the focus to the next item in the ribbon; Shift-Tab will move the focus in reverse order. Some groups do not have a Group Dialogue Box launcher.  
[bookmark: _Toc287434693] Available Home Ribbon Options

Clipboard: FO – Clipboard Dialogue Box
V – Paste from the clipboard Ctrl-V
X – Cut highlighted object or text to the clipboard Ctrl-X
C – Copy highlighted object or text to the clipboard Ctrl-C
FP – Format Painter Ctrl-Shift-C

Font:  FN – Font Dialogue Box Ctrl-D
FF – Font Face Ctrl-Shift-F
FS – Font Size Ctrl-Shift-P
FG – Grow Font Ctrl->
FK – Shrink Font Ctrl-<
E – Clear Formatting
1 – Bold (Highlighted text) Ctrl-B
2 – Italicize (Highlighted text) Ctrl-I
3 - Underline (Highlighted text) Ctrl-U
4 – Strikethrough (Highlighted text)
5 – Subscript (Highlighted text) Ctrl-=
6 – Superscript (Highlighted text) Ctrl-+
7 – Change case (Highlighted text)
I – Text Highlight Color
FC – Font Color	

Paragraph: PG – Paragraph Dialogue Box
U – Bullets 
N – Numbering
M – Multilevel List
AO – Decrease Indent
AI – Increase Indent
SO – Sort (Dialogue Box)
8 – Show or Hide Paragraph Symbol Ctrl-*
AL – Align Text Left Ctrl-L
AC – Align Text Center Ctrl-E
AR – Align Text Right Ctrl-R
AJ – Align Text Justified Ctrl-J (Block Text)
K – Line Spacing (1, 1.15, 1.5, 2, 3, Dialogue Box) 
H – Shading
B – Border
Style: FY – Font Style Dialogue Box Alt-Ctrl-Shift-S
L – Style (Heading, Title, Normal, etc.)
G – Change Styles
Editing
FD – Find Ctrl-F
R – Find and Replace Ctrl-H
SL – Select  
[bookmark: _Toc287434694]
Insert Ribbon
Alt-key followed by the N-key moves the focus to the Insert Ribbon

[image: C:\Documents and Settings\Administrator\Desktop\Office 2007 Pix\Insert Ribbon.jpg]
Available Insert Ribbon Options
Each option in a ribbon can be selected with a single or 2-letter key command. 
Tab key will move the focus to the next item in the ribbon; Shift-Tab will move the focus in reverse order. 
No group in the Insert Ribbon has a Group Dialogue Box launcher.  
Pages
V – Cover Page 
NP – Blank Page
B – Page Break Ctrl-Enter  
Tables
FD – Find 
R – Find and Replace
SL – Select  
Illustrations
P – Picture 
F – Clip Art
SH – Shape
M – Smart Art
C - Chart  
Links
I – Hyperlink Ctrl-K
K – Bookmark
RF – Cross-reference  
Header & Footer
H – Header 
O – Footer
NU – Page Number  
Text
X – Text Box 
Q – Quick Parts
W – Word Art
RC – Drop Cap
G – Signature Line
D – Date & Time
J – Object  
Symbols
E – Equation Alt-=
U – Symbol

[bookmark: _Toc287434695]
Page Layout Ribbon
Alt-key followed by the P-key moves the focus to the Page Layout Ribbon
[image: C:\Documents and Settings\Administrator\Desktop\Office 2007 Pix\Page Layout Ribbon.jpg]
Available Page Layout Ribbon Options
Each option in a ribbon can be selected with a single or 2-letter shortcut. 
Tab key will move the focus to the next item in the ribbon; Shift-Tab will move the focus in reverse order. 
Some groups in the Page Layout Ribbon do not have a Group Dialogue Box launcher.  
Themes
TH – Themes
TC – Theme Color
TF – Theme Font
TE – Theme Effects
Page Setup: SP – Page Setup Dialogue
M – Margins
O – Orientation
SZ – Size
J – Columns
B – Breaks
LN – Line Numbers
H – Hyphenation
Page Background
PW – Watermark
PC – Page Color
PB – Page Borders


Paragraph: PG – Paragraph Dialogue Box
IL – Indent Left
IR – Indent Right
SB – Space Before
SA – Space After
Arrange
PO – Object Position
AF – Bring to Front
AE – Send to Back
TW – Text Wrapping
AA – Align (List)
AG – Group
AY – Rotate



[bookmark: _Toc287434696]References Ribbon
Alt-key followed by the S-key moves the focus to the References Ribbon

[image: Reference Ribbon.jpg]
Available References Ribbon Options
Each option in a ribbon can be selected with a single or 2-letter short cut. 
Tab key will move the focus to the next item in the ribbon; Shift-Tab will move the focus in reverse order. 
Some groups in the References Ribbon do not have a Group Dialogue Box launcher.  
Table of Contents
T – Table of Contents
A – Add Text
U – Update Table
Footnotes: Q – Footnotes
F – Insert Footnote Alt-Ctrl-F
E – Insert Endnote Alt-Ctrl-D
O – Next Footnote
H – Show Notes
Citations & Bibliography
C – Insert Citation
M – Manage Sources
L – Style (Drop Down List)
B – Bibliography
Captions
P – Insert Caption
G – Insert table of Figures
V – Update Table
RF – Cross-reference
Index
N – Mark Entry Alt-Shift-X
X – Insert Index
D – Update Index
Table of Authorities
I – Mark Citation Alt-Shift-I
RT – Insert Table of Authorities
RU – Update Table


[bookmark: _Toc287434697]Mailings Ribbon
Alt-key followed by the M-key moves the focus to the Mailings Ribbon
[image: Mail Button.jpg]
Available Mailings Ribbon Options
Each option in a ribbon can be selected with a single or 2-letter short cut. 
Tab key will move the focus to the next item in the ribbon; Shift-Tab will move the focus in reverse order.
 No group in the Mailings Ribbon has a Group Dialogue Box launcher.  
Create
E – Create Envelopes
L – Labels
Start Mail Merge
S – Start Mail Merge
R – Select Recipients
D – Edit Recipient List
Write & Insert Fields
H – Highlight Merge Fields
A – Address Block
G – Greeting Line
I – Insert Merge Field
U – Rules
T – Match Fields
B – Update Labels
Preview Results 
P – View Merged Data
Q – First Record
M – Previous Record
W – Go to Record
X – Next Record
V – Last Record
J – Find Recipient
K – Auto Check for Errors Alt-Shift-K
Finish
F – Finish & Merge


[bookmark: _Toc287434698]Review Ribbon
Alt-key followed by the R-key moves the focus to the Review Ribbon
[image: C:\Documents and Settings\Administrator\Desktop\Office 2007 Pix\Insert Ribbon.jpg]
Available Review Ribbon Options
Each option in a ribbon can be selected with a single or 2-letter short cut. 
Tab key will move the focus to the next item in the ribbon; Shift-Tab will move the focus in reverse order. No group in the Review Ribbon has a Group Dialogue Box.  
Proofing
S – Spelling & Grammar F7 
R – Research Alt-Click
E – Thesaurus Shift-F7
L – Translate
PT – Translation Screen Tip
U – Set Language
W – Word Count
Comments
C – New Comment
D – Delete Comment
V – Previous Comment
N – Next comment  
Tracking
G – Track Changes Ctrl-Shift-E
TB – Balloons
TD – Final Showing Markup
TM – Show Markup
TP – Reviewing Pane
Changes
A – Accept
J – Reject
F – Previous
H – Next
Compare
M – Compare
O – Show Source Documents
Protect 
PR – Protect Document


[bookmark: _Toc287434699]View Ribbon
Alt-key followed by the W-key moves the focus to the View Ribbon
[image: C:\Documents and Settings\Administrator\Desktop\Office 2007 Pix\Insert Ribbon.jpg]
Available View Ribbon Options
Each option in a ribbon can be selected with a single or 2-letter short cut. 
Tab key will move the focus to the next item in the ribbon; Shift-Tab will move the focus in reverse order. 
No group in the View Ribbon has a Group Dialogue Box launcher.  
Document Views
P – Print Layout 
F – Full Screen Reading
L – Web Layout
U – Outline
E – Draft
Show / Hide
R – Ruler
G – Gridlines
D – Message Bar
VM – Document Map
H – Thumbnails
Zoom
Q – Zoom Dialogue 
J – 100% 
1 – One Page
2 – Two Pages
I – Page Width
Window
N – New Window
A – Arrange All
S – Split 
B – View Side by Side
VS – Synchronous Scrolling
T – Reset Window Position
W – Switch Windows
Macros
M – Macros Alt-F8


[bookmark: _Toc287434700]Developer Ribbon
Alt-key followed by the L-key moves the focus to the Developer Ribbon
[image: C:\Documents and Settings\Administrator\Desktop\Office 2007 Pix\Insert Ribbon.jpg]
Available Developer Ribbon Options
Each option in a ribbon can be selected with a single or 2-letter short cut. 
Tab key will move the focus to the next item in the ribbon; Shift-Tab will move the focus in reverse order. No group in the Developer Ribbon has a Group Dialogue Box.  
Code
V – Visual Basic Alt-F11
PM – Macros Alt-F8
R – Record Macro
S – Pause Recording
AS – Macro Security
Controls
Q – Rich Text
E - Text
I – Picture Content Control
CO – Combo Box
O – Drop-Down List
K – Date Picker
B – Building Block Gallery
N – Legacy Tools
DM – Design Mode
L - Properties
G – Group
XML
T – Structure
H – Schema
W - Transformation
X – Expansion Packs
Protect
PR – Protect Document
Templates
J – Document Template
DP – Document Panel
Note: If you never use the Developer Ribbon it can be removed in the Office Button, Word Options: Alt-key, f, I, Tab, Tab, Tab, Spacebar (uncheck the checkbox), Enter.


[bookmark: _Toc287434701]Add-Ins Ribbon
Alt-key followed by the X-key moves the focus to the Add-Ins Ribbon
[image: C:\Documents and Settings\Administrator\Desktop\Office 2007 Pix\Insert Ribbon.jpg]
[bookmark: _Toc287434702]Available Add-Ins Ribbon Options

Menu Commands – Menus inserted in the Word Ribbon during the installation of other programs. Your view of the Add-Ins Ribbon will vary. Some programs that add a menu to the Add-Ins Ribbon include:

Duxbury Braille Translation Program
OpenBook Scanning Program
Kurzweil Scanning Program
Tiger Software


[bookmark: _Toc287434703]Quick Access Toolbar
Alt-key moves the focus to the Ribbon Bar, followed by a number to access options on the Quick Access Toolbar. The Quick Access Toolbar can be customized by adding or removing commonly used tools. 
[image: C:\Documents and Settings\Administrator\Desktop\Office 2007 Pix\Insert Ribbon.jpg]
Default Quick Access Toolbar
1 – Save Ctrl-S
2 – Undo Ctrl-Z
3 – Redo Ctrl-Y
Alt, Shift-Tab, Enter Key – To customize the Quick Access Toolbar
[image: Quick Access Customize.jpg]
Add or remove options to your Quick Access Toolbar by adding or removing check marks. Add additional options by moving to the "More Commands".
[bookmark: _Toc287434704]
Add the, "Save as Office 2003" Option to the Quick Access Toolbar
When you save a file in MS Office 2007, the default format is a docx file. This format may not be compatible with some Braille note taking devices and older word processors. A file can be saved as a doc file by going through the "Save As" dialogue box and selecting "Word 97-2003". That option however, can be added to the Quick Access Toolbar, making the operation much quicker. 
	Default Quick Access
[image: Default QA.jpg]
	Customize Quick Access Dialogue Box

[image: Quick Access Word 97.jpg]



Adding a New Option to the Quick Access Toolbar
1. Press the Alt-key, F, I, C to open the "Word Options Customize Quick Access" dialogue box.
2. Tab to the "Choose Commands from" combo box and press the O-key, Enter to select the Office Menu list of options.
3. Tab to the list of options and press the W-key to select Word 97-2003.
4. Tab to the Add button and press Enter
5. Tab to the OK button and press Enter
6. You have now added the, "Save As 2003" (doc) file to the Quick Access toolbar.
Next time you want to save a document as a Word file in the 2003 format, press the Alt-key to access the Ribbon bar then press the 4-key. This will open the Save As dialogue box with the doc file extension pre-selected. 
Note: The number may change depending on how you customize the Quick Access tool bar.
Repeat the process above to add any number of options to the Quick Access toolbar. If you find yourself repeating the same tasks, look to customize the Quick Access toolbar. I typically do not add items that can be accomplished with a shortcut such as Save (Ctrl-S) or Print (Ctrl-P), etc. 
	New Quick Access Icon
[image: Quick Access 4.jpg]
	
Save As doc 
[image: Quick Access doc.jpg]



 



[bookmark: _Toc287434705]Picture Tools Format Ribbon 
Picture Tools Format Ribbon appears only when a picture is selected in the document. 
Alt-key followed by the JP-keys moves the focus to the Picture Tools Format Ribbon 

[image: C:\Documents and Settings\Administrator\Desktop\Office 2007 Pix\Insert Ribbon.jpg]
[bookmark: _Toc287434706]Available Picture Tools Format Ribbon Options

Adjust
B – Brightness 
N –Contrast
E – Recolor
M – Compress Picture
G – Change Picture
Q – Reset Picture
Picture Style
K – Picture Style
I – Picture Shape
SO – Picture Border
F – Picture Effects
Arrange 
PO – Position
AF – Bring to Front
AE – Send to Back
TW – Text Wrapping
AA – Align
AG – Group 
AY – Rotate
Size: SZ – Size Dialogue Box
C – Crop
H – Height
W – Width



[bookmark: _Toc287434707]Table Tools Design Ribbon
The Table Tools Design ribbon appears only when the cursor is located inside a table in the document. 
Alt-key followed by the JT-keys moves the focus to the Table Tools Design Ribbon 

[image: Table Design.jpg]
[bookmark: _Toc287434708]Available Table Tools Design Ribbon Options

Table Style Options
A – Header Row
T –Total Row
R – Banded Rows
M – First Column
N – Last Column
U – Banded Columns
Table Style 
S – Style 
H –Shading 
B – Borders
Draw Border: 0 – Draw Border Dialogue Box
L – Line Style 
W –Line Weight
C – Pen color
D – Draw Table
E – Eraser
[bookmark: _Toc287434709]Table Tools Layout Ribbon
The Table Tools Layout Ribbon appears only when the cursor is located inside a table in the document. 
Alt-key followed by the JP-keys moves the focus to the Picture Tools Format Ribbon 

[image: Table Layout.jpg]
[bookmark: _Toc287434710]Available Table Tools Layout Ribbon Options

Table 
K – Header Row
TG –Total Row
O – Banded Rows

Rows & Columns: I – Table Insert Cells Dialogue Box
D – Delete 
A – Insert Above
E – Insert Below
L – Insert Left
R – Insert Right
Merge
M – Merge Cells 
P –Split Cells
Q – Split Table

Cell Size: O – Table Properties Dialogue Box
F – Auto Fit
H – Height
W – Weight
UR – Distribute Rows
UC – Distribute Columns
Alignment 
TL – Align Top Left 
TC – Align Top Center
TR – Align Top Right
CL – Align Center Left
CC – Align Center
CR – Align Center Right
BL – Align Bottom Left
BC – Align Bottom Center
BR – Align Bottom Right
G – Text Direction
N – Cell Margins
Data
SO – Sort 
J –Repeat Header Row
V – Convert to Text
UL – Formula




Create and Navigate a Document
Microsoft Word 2010
[image: Word Work Area.jpg]
1. Student will identify and access major areas of the MS Word desktop.
a. Title Bar (Screen reader dependent)
b. Application Control Menu (Alt-Spacebar) – Restore, Minimize, Maximize, Move, Close
c. File Menu (Alt-key followed by the f-key) – Office Button (Word 2007)
d. Ribbon (Alt-key followed by a letter associated with each specific ribbon)
e. Quick Access Toolbar (Alt-key followed by a number associated with each specific tool)
f. Work Area – (Document window)
g. Status Bar – (Screen reader dependent)
2. Student will create a document by typing text into the document window.
3. Student will navigate an open document using standard Window commands


[image: Navigation.jpg]
Basic Navigation in Word 2010
Basic navigation skills begin by knowing where your cursor is located. As you enter text the screen reader can say the letter as you type and move on to the next space. To delete the letter just typed, use the Backspace key. When moving around a document with the arrow key the screen reader will say the letter the cursor is on. Visually it appears as if the cursor is located between letters, but it is always on a letter, space or punctuation mark. That is why the student will use the Delete key to delete the current letter and the Backspace key to delete the previous letter. 
The down arrow moves the cursor to a new line but the student may not know the exact position of the cursor. Use the Home key to jump to the beginning of the line and the End key to jump to the end of the line. The student can also use the arrow keys to move a few letters to help them locate the cursor.
Use the Ctrl-right arrow to move to the first letter of the next word. Repeat Ctrl-right arrow to move one word at a time to the right. The cursor is always located on the first letter of the word. 
Use the Ctrl-left arrow to move to the beginning of the current word and subsequent Ctrl-left arrow to move to the beginning of the previous word.  The cursor is always located on the first letter of the previous word. 
Jump to beginning of the current paragraph with a Ctrl-up arrow. Additional Ctrl-up arrow commands will move up the document one paragraph at a time. The cursor is always located on the first letter of each paragraph. 
Jump to the beginning of the next paragraph with a Ctrl-down arrow. Repeat Ctrl-down arrow to jump down the document one paragraph at a time. 
Jump to the top of the document with a Ctrl-Home key.
Jump to the bottom of the document with a Ctrl-End key.
[bookmark: _Toc287434711]Basic Navigation Commands Summary
· Top of Document – Ctrl-Home
· Bottom of Document – Ctrl-End
· One line down – Down arrow
· One line up – Up arrow
· One letter right – Right arrow
· One letter left – Left arrow
· One word right – Ctrl-right arrow (cursor on first letter of the word)
· One word left – Ctrl-left arrow (cursor on first letter of the word)
· Beginning of line – Home key
· End of line – End key
· Beginning of next paragraph – Ctrl-down arrow: Repeat Ctrl-down arrow to move to the beginning of next paragraph
· Beginning of current paragraph – Ctrl-up arrow: Repeat Ctrl-up arrow to move to beginning of previous paragraphs
· Move down one screen view – Page down key 
· Move up one screen view – Page up key
· Move down to the beginning of the next page – Ctrl-Page down: Repeat to move down the document one page at a time. 
· Move to the beginning of the current page – Ctrl-Page up: Repeat to move up the document one page at a time. 
Note: All of the above navigation commands help the student know the exact location of their typing cursor. The only commands not precise are the page up and page down commands. Those two commands may move the cursor half a page or more depending on the font size and zoom level among other settings. The other commands place the cursor at the beginning of a word, paragraph, or document.  



Highlighting Text
Microsoft Office 2010
[image: Highlight.jpg]


Student will learn to highlight text using the Shift-key along with a standard navigation command
Student will learn to unhighlight text 
Student will learn to cut, copy and paste highlighted text and undo errors
Highlighting text is as simple as holding the Shift-key down while using a standard Windows move command. Shift-right arrow moves the cursor one character to the right and because the Shift key was held down it also highlights the letter. Shift-Ctrl-right arrow highlights from the cursor location to the end of the word. Repeating the Shift-Ctrl-right arrow will highlight the next word; repeat as often as you like. Shift-down arrow highlights from the cursor location to the next line. A screen reader typically reads the highlighted text. 
[bookmark: _Toc287434712]Highlight Text Commands Summary
· Select the entire document – Ctrl-a
· Select from cursor location to top of document – Shift-Ctrl-Home
· Select from cursor location to bottom of document – Shift-Ctrl-End
· Select from cursor location down one line – Shift-Down arrow
· Select from cursor location up one line – Shift-Up arrow
· Select current letter and move cursor one letter to the right – Shift-Right arrow
· Select One letter left – Shift-Left arrow
· Select from cursor to end of current word right – Shift-Ctrl-right arrow (Repeat for next word right)
· Select from cursor to beginning of current word left – Ctrl-left arrow (Repeat for next word left)
· Select from cursor to beginning of line – Shift-Home key
· Select from cursor location to end of line – Shift-End key
· Beginning of next paragraph – Ctrl-down arrow: Repeat Ctrl-down arrow to move to the beginning of next paragraph
· Beginning of current paragraph – Ctrl-up arrow: Repeat Ctrl-up arrow to move to beginning of previous paragraphs
· * Move down one screen view – Page down key 
· * Move up one screen view – Page up key


[bookmark: _Hlk284842825]Cut, Copy, Paste Text
Microsoft Office 2007 & 2010[image: Cut-copy.jpg]
1. Student will copy and paste text within a single document.
2. Student will copy and paste text from one open document to another open document.
3. Student will copy text from the Internet to an Open Word Document.
4. Student will know how to keep or remove formatting while copying and pasting text.
5. Student will know how to undo and redo work in Word 2007.
[bookmark: _Toc287434713][image: word 2010 paste.jpg]Cut, Copy, Paste Text - Microsoft Word 2007
The cut, copy and paste commands work exactly like they did in MS Word 2003. If the student uses the shortcut commands, highlighted text can be copied to the clipboard with Ctrl-C, or cut to the clipboard with the Ctrl-x command.  Once on the clipboard, the text can be pasted to a different part of the document by moving the typing cursor to that location and using the Paste command, Ctrl-v. 
[image: paste options button.jpg]In Word 2007, you may notice the "paste options button" next to the end of your pasted text. This button allows a mouse user to choose to paste text with the original formatting, match the current formatting or just paste the plain text. Since this button is not readily accessible without the mouse it is best to simply eliminate this button and format pasted text manually. To eliminate this button, go to  Word Options inside the Office Button, (Press the Alt-key to move to the Ribbon bar, the f-key to open the Office Button (File menu), I-key to move to the Word Options button, A-key to the Advanced Options then press the Tab-key once. Next press the O-key (Oh) twice. You should hear your screen reader say, "Show Paste Options Button." Use your space bar to uncheck the check box in front of this option and press Enter. The next time you paste text it will paste it with the original formatting and without the paste options button icon. 
[image: Word Options - Cut Copy Paste.jpg]

If you wish, you can change the way your pasted text is formatted by changing the default options in the Cut, Copy, and Paste area of the Word Options. The options available are, to "Keep Source Formatting, "Match Destination Formatting", or "Keep text only."  The default formatting options are usually the best. Remember, you can always change the formatting of pasted text manually. 
[bookmark: _Toc287434714]Cut, Copy, Paste Text - Microsoft Word 2010
[image: word 2010 paste.jpg]There are some significant differences in the Paste command in Word 2010. The Paste Options Button is now accessible after you paste text by pressing the Ctrl-key. However, if you seldom use this option, you may want to eliminate the "Paste Options Button" just like we did in Word 2007 (see above). The Pasted text will appear as selected in your default settings. However, Word 2010 still gives you the option of selecting how you want the pasted text to appear. Just go through the Paste Options dialogue box on the Home Ribbon. (Alt-key moves the focus to the Ribbon Bar, H-key activates the Home Ribbon, and the V-key opens the Paste Options dialogue box. Inside the Paste dialogue box there are five options: K-Keep Source Formatting, M-Merge Formatting, T-Keep Text Only, S-Paste Special, and A-Set Default Paste (This takes you to the Word Options to change the default settings). The best way to navigate the Paste dialogue box is by the letter keys if you know them or to Tab through the 5 options. 
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Shortcut Command Summary
[bookmark: _Toc287434715]Useful Shortcut Commands - Word 2010
	Command
	Location
	Ribbon Command
	Shortcut

	New Document 
	Office Button
	Alt, f, n, Enter
	Ctrl-N

	Open Document
	Office Button
	Alt, f, o, 
	Ctrl-O

	Save Document
	Office Button
	Alt, f, s
	Ctrl-S

	Print Document
	Office Button
	Alt, f, p
	Ctrl-P

	Close Document (Keep Word Open)
	Office Button
	Alt, f, c
	Ctrl-F4

	Exit Word
	Office Button
	Alt, f, x
	Alt-F4

	Undo 
	Quick Access Toolbar
	Alt, 2
	Ctrl-Z

	Redo
	Quick Access Toolbar
	Alt, 3
	Ctrl-Y

	Clipboard Group Dialogue Box
	Home Ribbon
	Alt, h, fo
	None

		Paste from clipboard
	Home Ribbon
	Alt, h, v
	Ctrl-V

		Cut highlighted content
	Home Ribbon
	Alt, h, x
	Ctrl-X

		Copy highlighted content
	Home Ribbon
	Alt, h, c
	Ctrl-C

		Format Painter
	Home Ribbon
	Alt, h, fp
	Ctrl-Shift-C

	Font Group Dialogue Box
	Home Ribbon
	Alt, h, fn
	Ctrl-D

		Font Face
	Home Ribbon
	Alt, h, ff
	Ctrl-Shift-F (Ctrl-D)

		Font Size
	Home Ribbon
	Alt, h, fs
	Ctrl-Shift-P (Ctrl-D)

		Grow Font
	Home Ribbon
	Alt, h, fg
	Ctrl-> (greater sign)

		Shrink Font
	Home Ribbon
	Alt, h,fk
	Ctrl-< (less sign)

		Bold
	Home Ribbon
	Alt, h, 1
	Ctrl-B

		Italicize
	Home Ribbon
	Alt, h, 2
	Ctrl-I

		Underline
	Home Ribbon
	Alt, h, 3
	Ctrl-U

		Subscript
	Home Ribbon
	Alt, h, 5
	Ctrl -=

		Superscript
	Home Ribbon
	Alt, h, 6
	Ctrl-+ (Ctrl-Shift-=)

	Paragraph Group Dialogue Box
	Home Ribbon
	Alt, h, pg
	None

		Show or Hide Paragraph Symbol
	Home Ribbon
	Alt, h, 8
	Ctrl-* (asterisk) 

		Align Left
	Home Ribbon
	Alt, h, al
	Ctrl-L

		Align Center
	Home Ribbon
	Alt, h, ac
	Ctrl-E

		Align Right
	Home Ribbon
	Alt, h, ar
	Ctrl-R

		Justify
	Home Ribbon
	Alt, h, aj
	Ctrl-J

		Line Spacing
	Home Ribbon
	Alt, h, k
	Ctrl-2 (double line space) 

		Line Spacing
	Home Ribbon 
	Alt, h, k
	Ctrl-5 (1.5 line space)

	Style Group Dialogue Box
	Home Ribbon
	Alt, h, fy
	Alt-Ctrl-Shift-S 
(Not Fully Accessible)

	Find
	Home Ribbon
	Alt, h, fd
	Ctrl-F

	Find and Replace
	Home Ribbon
	Alt, h, r
	Ctrl-H

	Page Break
	Insert Ribbon
	Alt, n, b
	Ctrl-Enter

	Hyperlink
	Insert Ribbon
	Alt, n, I
	Ctrl-K

	Equation
	Insert Ribbon
	Alt, n, e
	Alt-=

	Footnote
	References Ribbon
	Alt, s, f
	Alt-Ctrl-F

	Endnote
	References Ribbon
	Alt, s, e
	Alt-Ctrl-D

	Mark Entry
	References Ribbon
	Alt, s, n
	Alt-Shift-X

	Mark Citation
	References Ribbon
	Alt, s, I
	Alt-Shift-I

	Auto Check for Errors
	Mailings Ribbon
	Alt, m, k
	Alt-Shift-K

	Spelling and Grammar Check
	Review Ribbon
	Alt, r, s
	F7

	Research
	Review Ribbon
	Alt, r, r
	(Not Fully Accessible)

	Thesaurus
	Review Ribbon
	Alt, r, e
	Shift-F7

	Track Changes
	Review Ribbon
	Alt, r, g
	Ctrl-Shift-E

	Macros
	View Ribbon
	Alt, w, m
	Alt-F8

	Visual Basic
	Developer Ribbon
	Alt, L, v
	Alt-F11

	Macros
	Developer Ribbon
	Alt, L, pm
	Alt-F8



Windows 7 Desktop
[bookmark: _Toc287434716]Navigating the Windows 7 Desktop
The Window Key activates the Windows 7 Start Menu
[image: 7 Desktop.jpg]

Everything in Windows starts with the Desktop. It is the "program" running when Windows boots up. The desktop contains icons representing documents, files, folders, and programs. The lower left corner of the desktop contains the Start Menu. The Start Menu provides access to every part of the operating system. Next to the Start Menu is the taskbar, followed by the System Tray. 
Moving to a Desktop Icon: Window key- d (desktop) or Window key- m (minimize all) will minimize all running programs and move the focus to the desktop. Use the up, down, right or left arrows to find the icon you want. First letter navigation is also available. Press the a-key to find an icon starting with the letter a (Adverbs). 


[image: Start Button search field.jpg]Opening the Start Menu: Press and release the Window key (second key to the left of the spacebar on a standard keyboard). In Windows 7, the focus is in a search edit field. Type in the first 3 – 4 letters of the program, document or folder you are looking to open. Press the down arrow to explore the list of suggestions. When you locate the item press Enter to open it. If you have pinned items to your Start Menu, you can use the down or up arrows to locate it and Enter-key to open it.
Moving to the Taskbar: The Tab-key moves the focus to any part of the Windows desktop. Window key-d moves the focus to the desktop icons. Pressing the Tab key will move the focus to the Window key, Taskbar, System Tray and finally back to the desktop icons. Once on the Taskbar you can move to item pinned to the taskbar with the right and left arrow keys. 
Moving to the System Tray: The Tab-key moves the focus from the Taskbar to the System Tray. Once on the system tray you can move to any item with the right or left arrow keys. Another way of working with System Tray icons is with your screen readers command. JAWS creates a list of System Tray icons with Ins-F11. Use the up down arrows to select and Enter to open a program. 
Fast Switch Between Active Programs: If you have two or more programs running at the same time, you can quickly move to and activate any one of them. Hold down the Alt-key and press the Tab key. This will switch back to the last active program. If you hold down the Alt-key, then press Tab key repeatedly you can cycle through multiple active programs. Let go of the Alt-key only when you move the program you want to be active. 
Application Key: The Application key is located three keys to the right of the spacebar on a standard keyboard. This key is the equivalent of a right mouse click. Right clicking on icons or other Window elements provides you with a handy little menu. Hold down the Window key and press d-key to go to your desktop. Press the r-key until the focus is on the Recycle bin. Now press the Application key to activate the menu. Press the down arrow to move through the menu options. Press Enter on "Empty Recycle bin". You have other options such as rename the icon or find out the properties of the recycle bin. In Microsoft Word you can move to a misspelled word, press the Application key and get a list of suggested replacement words. The Application key can be very handy and is an important key for students to know how to use.  
Windows Explorer: Windows Explorer is the file management program in Windows 7. It also provides access to System Properties, Uninstall Programs and Control Panel. You can open it from anywhere in Windows by holding down the Window key and press the E-key. 
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